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IMPORTANT: Read this license agreement before removing the Program
Diskette or Documentation from its protective cover. Removing the diskette
or documentation will constitute agreement to the conditions of this end-
user license agreement. If you are not willing to be bound by the terms of this
license agreement, promptly return the unopened package to RADWORKS
Corporation (hereafter RADWORKS Corp.) with a copy of the receipt, and your
license fee will be refunded.

PROGRAM LICENSE AGREEMENT

RADWORKS Corp. has worldwide rights to copy, publish, seli, license and distribute
RadWorks, including Software, Program Diskette and Documentation (hereafter collectively
referred to as PRODUCT). You assume responsibility for the selection of the program to achieve
your intended results, and for its installation and subsequent use.

GRANT OF LICENSE :
RADWORKS Corp. hereby grants to Licensee non-exclusive license to use the PRODUCT upon
the terms and conditions contained in this agreement.

You may:
1) use the PRODUCT on a single workstation owned, leased or otherwise controlled by you.

2) copy the PRODUCT for backup purposes in support of your use of the PRODUCT on the single
workstation.

3) modify the PRODUCT an/or merge it into another program for your use on the single |
workstation. (Any merged or modified portion will continue to be subject to the terms and
conditions of this agreement).

4) transfer the PRODUCT and license to another party if;

a) the other party agrees to accept the terms and conditions of this agreement, and
b) the transfer is approved, in writing, by RADWORKS Corp.

You may not:

1) use the PRODUCT, or merged or modified portion of the PRODUCT, on more than one
workstation unless specified by a license agreement. This is to include all Jocat area or other
network configurations.

2) copy, rént, distribute, sell, license, sublicense, assign or otherwise transfer the PRODUCT to
another party except as expressly allowed under item 4.




The use of PRODUCT, or any portion of PRODUCT, including dynamic link libraries, in any
program or system which is rented, distributed, sold, licensed, sub-licensed or otherwise
transferred to another party or individual is specifically prohibited under the terms of this
license. Also, the development and distribution of stand-alone modules, or modules requiring
RADWORKS to operate, is specifically prohibited, Additional licensing from RADWORKS
Corp. is required for these purposes. For further information, please contact RADWORKS Corp.
at:

RADWORKS Corporation
P.O. Box 690376
San Antonio, Texas 78269
(512) 691-2803

RIGHTS OF RADWORKS CORPORATION

You acknowledge and agree that the PRODUCT contains proprietary material of RADWORKS
Corp. protected under U.S. copyright, trademark and trade secret laws. All right, title and
interest in PRODUCT are and shall remain with RADWORKS Corp. This agreement does not
convey to you any title or interest in the PRODUCT, only the limited right of use which may be
terminated as provided for herein. you agree to use you best efforts to protect the PRODUCT
from use, reproduction, or other distribution except as specifically allowed under this license.

TERMS

This license is effective until terminated. You may terminate the license at any time

returning the PRODUCT, all copies, and merged or modified portion of PRODUCT (and all
copies of documentation) to RADWORKS Corp. This license will automatically terminate
without notice by RADWORKS Corp. if you fail to comply with any terms or condition of this
agreement, You agree upon such termination to return the PRODUCT, all copies, and merged or
modified portion of PRODUCT (and all copies of documentation) to RADWORKS Corp.

LIMITED WARANTY

RADWORKS Corp. warrants the diskettes on which the PRODUCT is furnished, to be free from
defects in material and workmanship under normal use, for a period of ninety (90) days from the
date of purchase as evidenced by a copy of you receipt.

Except as specified above the PRODUCT is provided "as is" without warranty of any kind,
ejther expressed or implied, including, but not limited to the implied warranties of
merchantability and fitness for a particular purpose. The entire risk as to the quality and
performance of the PRODUCT is with you, should the PRODUCT prove defective. You (and not
RADWORKS Corp. or any authorized dealer of PRODUCT) assume the entire cost of all
necessary repair, or correction.

LIMITATION OF LIABILITY
RADWORKS Corp.’s entire liability and your exclusive remedy shall be:

1} the replacement of any diskette not meeting RADWORKS Corp.'s Limited Warranty; or



2) if RADWORKS Corp. is unable to deliver a replacement diskette which is free of defects in
material or workmanship, you may terminate this agreement and have your license fee
refunded by returning all copies of the PRODUCT and copy of your receipt to RadWorks Corp.

In no event will RADWORKS Corp. be liable to you for any indirect, spedal, exemplary,
incidéntal or consequential damages, claims or actions including lost profits or lost savings, or
other damages arising out of the use or inability to use this program even if RADWORKS Corp.
or it's authorized dealer has been advised of the possibility of such damages.

Some states do not allow the 1im.itab'6n or exclusion of liability for incddental or consequential
damages so the above limitation may not apply to you.

TRADEMARK

RADWORKS™ is a registered trademark of RADWORKS Corporation. No right, license, or
interest to such trademark is granted hereunder.

GOVERNING LAW

This agreement shall be governed and construed in accordance with the laws of the State of
Texas applicable to agreements made and to be performed in the State of Texas.

SEVERABILITY

Should any term of this agreement be declared void or not enforceable by any court of competent
jurisdiction, the remaining terms shall remain in full effect.

WAIVER

Failure of either party to enforce any of its rights in this agreement or take action against the
other party in the event of a breach of this agreement shall not be considered a waiver of the
right to subsequent enforcernent of its rights, or actions in the event of subsequent breaches by the
other party. - .

COMPLETE AGREEMENT

You acknowledge that you have read this agreement, understand it and agree to be bound by its
terms and conditions. You further agree that it is the complete and exclusive dgreement between
us and supersedes any proposal or prior agreement or other communication, oral or written,
between us relating to the subject matter of this agreement.
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Installing RADWORKS

RADWORKS is a Microsoft® Windows-based application allowing you to
acquire, save, process and analyze digital radiographic images. Since
RADWORKS runs in the Microsoft Windows graphical user interface
environment, you must install one of the following versions of Windows:

The full retail version of Windows 3.0. _
Installing the full retail version of Windows provides you with all Windows
functions, including the Program Manager and File Manager applications.
For a complete description of Windows function, see the Microsoft Windows
User's Guide.

The version of Windows 3.0 supplied by some computer manufacturers,
tailored to the requirements of that computer. Like the full retail version of
Windows, this version provides you with all Windows functions.

What This Guide Explains

Required hardware and software.
How to install your RADWORKS software.
How to install your x-ray sensor hardware.

You should also read the file called README.TXT, included on your
RADWORKS program disk. This file contains useful information about the
latest RADWORKS developments. You can open and read this file using the
Windows Notepad application. Print a copy of the README.TXT file to keep
with you RADWORKS User’s Manual.

What your RADWORKS package includes

Read this section to make sure you software package is complete and you
have all the equipment you need. Carefully read the License Agreement. If
you accept the terms of the License Agreement, open the disk pack and fill out
the registration card. Return this card to RADWORKS Corporation to receive
technical support and software upgrade notices.

The RADWORKS User’s Manual.
The Software License Agreement printed on a sealed envelope.
A set of the following disks (inside the envelope):
(1) 5.25 inch, 1.2 MB floppy disk, and
(1) 3.5 inch, 1.44 MB floppy disk
A registration card inside the envelope.



Hardware and Software in the RADWORKS System
Hardware requirements:

Computer system.

RADWORKS will run on any Windows 3.0-compatible IBM® PC AT or
compatible computer. RADWORKS recommends an Intel 80386 or 80486 based
system with a minimum of four megabytes of RAM. The computer must
have at least one empty, full-length expansion slot into which you will install
your x-ray detector interface or a frame grabber board to acquire images. A
math coprocessor will accelerate image processing functions but it is not
required.

Computer monitor.

An 8-bit SuperVGA color display controller with non-interlaced 1024 x 768
pixels is needed to drive a multisync monitor. RADWORKS recommends a .
Sigma Designs Legend display controller and a NEC 4DS monitor.

Disk space. _ .

You need 2.0 megabytes of available disk space to install RADWORKS.
Approximately 4.0 megabytes of disk space is needed to save each full mouth
survey of 24 images. RADWORKS recommends that you have a minimum of
650 megabytes of available disk space for patient images. The disk space may
be either fixed hard disk or removable optical disk.

X-ray detector system.

RADWORKS currently supports the Sens-A-Ray™ system from REGAM
Medical Systems AB. Contact RADWORKS Corporation for the latest
information on x-ray system support.

Mouse.
You need a mouse or other pointing device compatible with M5 Windows
3.0.

Hardware key.

A hardware key is provided with each copy of the RADWORKS program. This
hardware key must be installed on the parallel printer port at all times for the
RADWORKS program to function. The hardware key will in no way affect the
performance of the computer or parallel port. :

Software requirements:

To run RADWORKS , you need PC- or MS-DOS version 3.1 or later, Microsoft
Windows version 3.0 or later, and the RADWORKS program.
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Installing RADWORKS Software

Before installing your software, make backup copies of your disk in case the
originals are accidentaily destroyed. Then use the backup copies to install the
software on your hard disk.

RADWORKS runs under Microsoft Windows version 3.0. If you already have
Windows installed on you system, you need only install the RADWORKS files
using the automatic installation program. If Windows 3.0 (or higher) has not
been installed, install it now.

In order to install RADWORKS, you must know which hard drive the
RADWORKS software is going to be installed on.

To install RADWORKS on your hard disk:

1. With the power turned OFF on your computer, install the RADWORKS
hardware key to the computer's parallel communications port at the back of
your computer. This hardware key will in no way affect the performance of
you computer or parallel port.

2. Turn the power ON and start your computer.

1. Start Microsoft Windows 3.0 by typing "win" at the C: prbmpt.

2. Insert the RADWORKS Program Disk into a drive.

3. Select Run from the File menu.

4. Type "A:\install.exe" or "B:\install.exe” dependent upon the drive you are
using. Next select the OK button.

4. Follow the instruction on your screen. The RADWORKS installation
program will prompt you for necessary information it needs to install
RADWORKS.

5. Finally, Reboot the corhputer.

6. Refer to RADWORKS Basic Skills section for instruction on using
RADWORKS software.
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Installing X-ray Sensor Hardware

The following is copyrighted material taken from the Sens-A-Ray™ Owner’s
Manual and Reference Guide REGAM Medical Systems AB.

The following components should be included in the Sens-A-Ray™ system:

- X-RAY sensor of CCD-type.

- A dockgenerator and A/D board = A/D Box.
- AC/DC power supply.

- Frame grabber.

- Al cables and connectors.

Optional components:

- CD-Worm (Write Once Read Many) optical disk storage device.
- Videoprinter for hard copies of images.
- Remote control for the system.

Please follow these instructions to install the framegrabber and SuperVGA
card in you computer. You are also given instructions how to install the
monitor, A/D Box, and the AC/DC power unit.

1. Turn off your computer and the power to any peripheral devices attached
to your computer (such as printers, monitors, videoprinters, CD-WORM
drive unit, etc.)

‘2. Turn the system unit so that the back of the unit faces you. Disconnect the
power cord and any other cables from the back of the computer.

3. Remove the system unit cover. (If necessary, refer to your computer user's
guide.)

4. Locate the expansion slots at the rear of the system unit, and choose two
expansion slots. (If necessary, refer to your computer user's guide to
determine how the expansion slots in you system unit are numbered.)

5. Remove the screw that secures the expansion slot covers to the system unit,
as shown in the following figure. Then carefully remove the slot covers.
Picture

6. First grasp the upper edges of the framegrabber card. Press the board firmly
into the socket. '
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7. Make sure the slot on the top of the metal retaining bracket lines up with
the hole on the top of the expansion slot. ” |

8. Then grasp the upper edges of the SuperVGA card. Press the board firmly
into the second empty slot.

9. Make sure the slot on the top of the metal retaining bracket lines up with
the hole on the top of the expansion slot.

10. Replace the system unit cover. Reconnect any cables you removed in step

11. Take the cable that is supplied with the multi-sync monitor and connect
one end to the female connector at the back of the screen. The other end is
connected to the female connector on the SuperVGA card that you have just
installed.

12. Connect the power cord from the screen either to the mains or the |
computer, depending upon which type of power cord is supplied with the
monitor. '

13. Take the short cable that is supplied with the AC/DC power supply and
slide the small male connector into the framegrabber card’s female connector
at the back of the computer. Take the other end of the cable and the large male
connector and slide it into the large female connector on the AC/DC power

supply.

14. At one end of the AC/DC power supply is a cable stationary fixed to it. The
other end of this cable is connected pennanently to the A/D Box.

15. Place the A/D Box on the X-ray tube with the velcro closing that is
supplied with your installation kit.

16. Install the cable between the AC/DC power supply and the A/D Box. Use
the velcro closing or the clips supplied with your installation kit.

17. The Sens-A-Ray™ sensor is already connected to the A/D Box and after
installing the A/D Box the sensor is placed on the special hook that is
supplied with the A/D Box.

18. You have now completed the installation of the hardware that is used in
connection with the Sens-A-Ray™ sensor. You are now ready to power up
the system and test the device. | ‘

19. Turn on the green switch on top of the AC/DC power supply.
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20. Set the power switch on the monitor to the ON position.
21. Turn the power switch on the computer to the ON position.
22. Refer to the User's Manual further instructions.

Congratulations, you have completed the installation proceduret!!
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RADWORKS Basic Skills

This chapter introduces you to the basic operation of RADWORKS. Before you
begin working in RADWORKS, read and follow the examples and procedures
to become familiar with using the program.
RADWORKS is an integrated program for the acquisition, processing, analysis,
storage and retrieval of digital radiographic examinations. The program is
designed to interface with the image sensor and acquisition hardware
provided by the manufacturer. ' 3 -
While RADWORKS is a sophisticated software application, it can be used
effectively by novice and expert computer users alike. Explore the flexibility
and ease of use designed into the application.
What You Should Know
This chapter assumes you are familiar with the operation of Microsoft
Windows graphical user interfaces. To operate such software you must
master the following skills: "

Basic mouse actions: drag, click, double-click, click-and-drag |

Selecting commands from pull-down menus

Stretching and moving windows

Selecting items from list boxes

Selecting commands from pop-up lists

Moving through directories and files
If you do not have these skills, consult your Windows documentation. If you
are even slightly familiar with the concepts, go ahead and start. You will
master them in the process of using RADWORKS.
Starting and Exiting RADWORKS

Starting from the Windows Program Manager

The most common way to start RADWORKS is to start Windows, then launch
RADWORKS from the Program Manager.
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1) From the DOS prompt, enter the following to display the Windows
Program Manager: "win".

2) From the File menu, select Run. The Execute dialog box appears.

3) Type "C:\RADWORKS\RADWORKS.EXE", then press the Enter kéy. The
program window appears. As RADWORKS starts, you will see initialization
messages appear in the status dialogue box.

Starting RADWORKS from an Icon

If you have placed the RADWORKS.EXE program in the Program Manager
Window, the RADWORKS Icon will appear in the window. Then simply
double-click on the RADWORKS Icon to start the program.

Exiting RADWORKS

To exit the program:

1) Using the mouse, move the cursor to the ﬁpper left corner of the
RADWORKS program window.

2) Double-click on theWmdow Command Menu icon.

Aborting or Escape Procedure
In order to abort or escape any procedure:
1) Using the mouse, select the Clear from the Window menu.

2) This will abort any procedure and return you to the beginning of any
procedure,

Getting Help
RADWORKS offers extensive on-iine help for all levels of expertise. The Help

menu, located at the far right side of the menu bar, provides access to all the
help tools.
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RADWORKS Tutorial
Getting Started

Before attempting this part of the manual, make sure you have installed and
configured RADWORKS and the X-ray sensor hardware according to
instruction in the Installation Guide.

If you have not read the entire RADWORKS manual, at least read,
"RADWORKS Basic Skills", to get the general idea of manipulating the menus
and the mouse.

How to perform a digital radiographic examination

The following is a step-by-step guide to performing a digital radiographic
examination using RADWORKS. The first step is to input the patient
information and then the information relating to the examination. Next you
must position the detector in the patients mouth and make an exposure. The
image is first checked for quality and then correctly oriented for future
viewing. Finally the image is placed in the image holder and subsequent
images are taken until the examination is complete. The examination is then
stored for later retrieval. Each step in this procedure will be explained in this
chapter. '

To perform an examination of a new patient:

Entering patient and examination information

¢ Select New from the Exam menu.
o The Enter Patient Info dialog box will be displayed. (picture)

e Type either a portion of the patient's last name or the patient's chart
number. Do Not Type Both.

o Choose the Look-up button at the bottom of the dialog box.
e The Select A Patient dialog box will now appear, displaying the names of
all patients which meet the criteria entered. Since this is a new patient the

list should be not contain the patient's name. (picture)

e Choose the New button at the bottom of the dialog box to make a new
patient record.

¢ The Add New Patient dialog box will be displayed. (picture)
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Type the patient's first name, then press the "tab" key.
Type the patient's middle name or initial, then press the "tab” key.

Type the patient’s last name, then press the "tab” key. Repeat this
procedure until all the fields are completed.

Choose the Add button at the bottom of the dialog box.

The Examination Information window will be displayed. (picture)

The patient information and time/date will automatically be entered into
the examination form.

Type the referring doctor’s name, then press the “tab” key.

Type the referring service, then press the "tab" key.

Using the mouse select the Modality from the popup menu.

Using the mouse select the Exam Type from the popup menu.

Review the information. Choose the Acquire button at the bottom of
the dialog box.

The Acquisition Control dialog box will be appear on the left side of the
Image window showing the number of exposures selected and the

" number of exposures taken. And the Image Holder icon will

appear in the upper right next to the Examination Information window.
These will both be discussed in detail later. You are now ready to take
radiographic images.

(Picture of the acquisition screen with all components labeled.)

X-ray sensor and sensor placement

o Place the detector in the plastic sheath to prevent contamination of the

detector.

Using the appropriate aiming device and detector holder, place the
detector in the patient's mouth. The position of the detector is identical to
that used with conventional film based systems.

Position the x-ray tube head in alignment with the image detector.
You are now ready to make an exposure

20



Making a radiographic exposure

* The recommended exposure parameters are described in the appendix.

Different x-ray generators may vary in the appropriate exposures and some
initial testing of exposure parameters may be necessary. Set the exposure
parameters on the x-ray generator.

* Using the mouse select the Expose button in the Acquisition Control
dialogue box. (picture) A green GO light will be displayed indicating the
system is ready for an exposure. If you do not make an exposure within 15
seconds an Exposure Error dialog box will be displayed. This is to protect
the sensor from damage. You will need to select the Expose button again.

¢ Next press the exposure control to trigger the x-ray machine. Shortly after
the exposure, the x-ray image will be displayed in the Image window
located in the ceriter of the computer screen. The Acquisition Tools
palette will be appear on the right side of the Image window.

Image orientation and positioning

+ Inspect the image to insure that the exposure is correct and that all
relevant anatomic structures have been included in the image.

» Using the Acquisition Tools palette "rotate” or "flip" the image so that is
is oriented correctly. This is done by determining the appropriate
orientation of the image to be placed in the image holder and selecting the
necessary orientation buttons from the palette. Rotation both clockwise
and counterclockwise by 90° and by 180° are supported. Also the image can
be "flipped” about the horizontal or vertical axis. "Flipping" the image
about the horizontal axis is used to correctly orient the image of the upper
or lower dental arches, while "flipping” about the vertical axis is used to
correctly orient the image of the left or right sides of the patient.

¢ Once the image is in the correct orientaﬁon, place the iinége in the
appropriate position in the Image Holder icon by dlicking the mouse in
the desired open space.

e The space will immediately become grayed, indicating that the image has
been accepted in the Image Holder icon. The number of exposures to be
taken will decrease by one and the number of images taken will be
increased by one. ' '

¢ You are now ready to make the next exposure. Repeat these steps until all

images have been taken for the examination. Once all images have been
taken, the Complete button will become active.
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Saving an Examination

To

Select the Complete button at the bottom of the Acquisition Control
dialog box. The examination will automatically be saved to the image
storage device.

perform a new examination of an existing patient:
Select New from the Exam menu.
The Enter Patient Info dialog box will be displayed. (picture)

Type either a portion of the patient's last name or the patient's chart
number. Do Not Type Both.

Choose the Look-up button at the bottom of the dialog box.

The Select A Patient dialog box will now appear, displaying the names of
all patients which meet the criteria entered. (picture)

Select the patient's name from the list. (If the patient’s name does not
appear, no record exists, Check your information or choose the New
button at the bottom of the dialog box to make a new patient record as
described above.)

The Examination Information window will now be displayed. (picture).
The patient's name, chart number and date of birth along the the current
time and date information will automatically be entered.

Type the referring doctor’s name, then press the "tab” key.

Type the referring service, then press the "tab" key.

Using the mouse select the Modality from the popup menu.

Using the mouse select the Exam Type from the popup menu.

Review the information. Choose the Acquire button at the bottom of the
dialog box.

You are now ready to take radiographic images. Follow the same
instructions as given above for a new natient.



How to retrieve a digital radiographic examination

The following is a step-by-step guide to retrieving and reviewing a digital
radiographic examination using RADWORKS. The first step is to "ask" or
query the RADWORKS system and to select the examination that is needed.
Many different examinations may be present for the same patient. After the
examination has been retrieved, you will need to select the radiographs to be
viewed. Next you may wish to perform certain image processing or image
analysis functions on the radiographic images. Finally you will need to clear
the examination from the computer screen.

To retrieve an examinatt’ﬁln‘ .of .a‘ pattent

Finding the patient record

¢ Select Find from thé. Exam menu.

e The Enter Patient Info dialog box will be displayed. (pictu.re?)

¢ Type either a portion of the patient's last name or the patient's chart
number. Do Not Type Both.

* Choose the Look-up button at the bottom of the diaiog box.

e The Select A Patient dialog box will now appear, displaying the names of
all patients which meet the criteria entered. (picture)

¢ Select the pal:iént's name from the list. (If the patient's name does not
appear no record exists, check your information.)

Finding the examination

e If more than one examination exists for the patient, the Select An Exam
dialog box will now appear, displaying a list of all radiographic
examinations which have been performed on that patient. (picture)

¢ Select the examination from the list which you wish to view.

¢ The examination information will be displayed along with an icon
representing the appropriate film holder.

Automatic display mode

This is the default display mode. A single image is displayed in the center of
screen. Only one image can be displayed at a time. This mode is designed to
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allow the clinician to view one image at a time in a predefined order or
randomly. The predefined order can be set from the preference menu.

¢ To view the images in a predefined order, simply place the cursor in the
Image Window and click the mouse. The next image will be displayed
and the Image Holder Icon will indicate the image being displayed by
appearing transparent. Alternatively the "Space” bar can be used to
advance to the next image to be displayed.

* To view the images in a random order, simply point to the image you
wish to be displayed in the Image Holder lcon and dlick the mouse. The
image will then be displayed in the Image Window.

Manual display mode

This is the optional display mode. Any number of images can be displayed
simultaneously. This mode is designed to allow the clinician to view as many
images as desired at the same time. This can be useful when comparing
images which display the same anatomical area.

o Select the Manual button at the lower right of the Examination
Information Window.

» Select the image to be displayed by clicking on the Image Holder Icon and
dragging the image into the viewing area. The image will be displayed in a
Image Window which can be resized and repositioned to any location on
the screen.

e To put the image away, simply click the iconize arrow in the upper right
corner of the Image Window.

» The images which are being displayed will be indicated by the transparent
icons in the Image Holder Icon.

e To revert back to automatic display mode, simply click on the Automatic
button at the lower right of the Examination Information Window.
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RADWORKS Menus

This chapter introduces you to the RADWORKS menus. Before you begin
working in RADWORKS , read and follow the examples and procedures to
become familiar with using the program. All of the basic functions necessary
to acquire, process, analyze, store and retrieve digital radiographic
examinations are explained in this chapter. '

The Exam Menu

This group of menu items provides for entering new patient/examination
information and acquiring radiographic images into the RADWORKS system.
Also provided is the ability to retrieve, edit or delete a specific radiographic
examination. _ _

New

This command allows you to take a new radiographic examination.

To perform an examination of a new patient:

e Select New from the Exam menu.

» The Enter Patient Info dialog box will be displayed. (picture) .

o Type either a portion of the patient's last name or the patient’s chart
number. Do Not Type Both.

¢ Choose the Look-up button at the bottom of the dialog box.

e The Select A Patient dialog box will now appear, displaying the names of
all patients which meet the criteria entered. Since this is 2 new patient the
list should be not contain the patient’s name. {picture)

¢ Choose the New button at the bottom of the dialog box.

e The Add New Patient dialog box will be displayed. (picture)

» Type the patient's first name, then press the "tab” key.

e Type the patient's middle name or initial, then press the "tab" key.
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To

Type the patient's last name, then press the "tab" key. Repeat this
procedure until all the fields are completed.

Review the information. Choose the Add button at the bottom of the
dialog box.

The Examination Informatioi_: window will be displayed. (picture)
The patient information and time/date will automatically be entered into
the examination form.

Type the referring doctors name, then press the "tab" key.

Type the referring service, then press the "tab" key.

Using the mouse select the M'dd}zlity from the POpUp menu.

Using the mouse select the Exam Type from the popup menu.

Review the information. Choose the Acquire button at the bottom of the
dialog box.

You are now ready to take radiographic images.

perform a new examination of an existing patient:
Select New from the Exam menu. o
The Enter Patient Info dialog box will be displayed. (pichue) -

Type either a portion of the patient's last name or the patient's chart

- number. Do Not Type Both.

Choose the Look-up button at the bottom of the dialog box.

The Select A Patient dialog box will now appear, displaying the names of
all patients which meet the criteria entered. {picture)

Select the patient's name from the list. (If the patient’s name does not
appear, no record exists. Check your information or choose the New
button at the bottom of the dialog box to make a new patient record as
described above.)

The Examination Information window will now be displayed. The

patient, time and date information will automatically be entered into the
examination form. (picture)
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Type the referring doctors name, then press the "tab” key.
Type the referring service, then press the "tab" key.

Using the mouse select the Modality from the popup menu.
Using the mouse select the Exam Type from the popup me;lu.

Review the information. Choose the Acquire button at the bottom of the
dialog box.

You are now ready to take radiographic images.

Find

This command allows you to retrieve and display of an existing radiographic
examination.

To retrieve an examination of a patient:

Select Find from the Exam menu.
The Enter Patient Info dialog box will be displayed. (picture)

Type either a portion of the patient's last name or the patient's chart
number. Do Not Type Both.

Choose the Look-up button at the bottom of the dialog box.

The Select A Patient dialog box will now appear, displaying the names of
all patients which meet the criteria entered. (picture)

Select the patient's name from the list. (If the patient's name does not .
appear no record exists, check your query information or choose the New
button at the bottom of the dialog box to make a new patient record.)

If more than one examination exists for the patient, the Select An Exam
dialog box will now appear, displaying a list of all radiographic
examinations which have been performed on that patient. (picture)
Select the examination from the list which you wish to view.

The examination information will be displayed along with an icon of the
appropriate film holder. .
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Edit

This command allows the user to modify or edit the contents of an
examination. This feature should be used with extreme caution as you are
changing a medical-legal record. This command is password protected to
prevent unauthorized modification of patient's records.

Delete

This command allows the user to delete an examination. This feature should
be used with extreme caution as you are changing a medical-legal record. This
command is password protected to prevent unauthorized deletion of
patient's records. |

Exit

This command exits the RadWorks program and returns to the Program
Manager application.

The Pmcesé Menu

This group of menu items provides for a wide range of image processing
functions designed to enhance the visualization of information within the
image. The selection of the appropriate function is task dependent and
requires some practice. The original image data will not be changed by these
functions. You may experiment with different processing functions to
enhance the image. The command can be applied to the entire image or a
selected portion. '

Contrast
This command allows you to interactively manipulate the contrast and
brightness of the image using slider control bars. It also provides for several

modified contrast scales such as linear, inverse, variable gamma. This process
is applied to the entire image.
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Sharpen

Sharpens images with high frequency components; accentuates edges. This
process is equivalent to a Hi-Pass filter. This process is applied to the entire
image.

Blur

Blurs the image and reduces overall image noise. This process is equivalent
to a Lo-Pass filter. This process is applied to the entire image.

Math

This command allows you to perform mathematical operations using two
images or one image and a constant value. These operations include addition,
subtraction, multiplication and division.

Filters

This command allows you to apply convolution filters to the image.
Generally these filters are designed to enhance features or remove noise. A
filter may be applied to an area of interest (AOI) or the entire image. For more
information on convolution filters see Appendix A.

Revert Image

This command allows you undo the previous processing operation.

The Analyze Menu

This group of menu items provides for a wide range of tools to quantitatively
analyze information within the digital image.

AOI Histogram

This command tells RADWORKS to calculate and display a histogram of the
distribution of gray values in the AOL The mean gray value and its standard
deviation are also calculated. A histogram is displayed as a two-dimensional
graph, Each value along the horizontal X-axis represent a gray scale value.
The values along the vertical Y-axis represent the number of pixels in the
image that are of that gray value. In general, the histogram gives us a clue as
to what contrast enhancements will improve the image.



To perform an AOI histogram:
o Select AOI Histogram from the Analyze menu.

e Define an AQI with the Selection Tool or select the entire image by
clicking in the image window.

¢ The Analysis Results window will appear, displaying the histogram
along with the mean gray value and its standard deviation.

e Click on the Analysis Results window close box to end the procedure.
Point Histogram

This command returns the gray value and X-Y coordinates of the pixel
directly beneath the cursor. ' -

To perform an point histogram:
o Select Point Histogram from the Analyze menu.

e The cursor will change to a cross-hair. Position the cursor on the pixel" of
interest. ' ' '

o The Analysis Results window will appear, displaying the X-Y coordinates
and gray value of the pixel beneath the cursor. The value will change as
the cursor is moved in the Image window .

s Click on the Analysis Results window close box to end the .proéedure.

Line Profile

This command displays a two-dimensional graph that represents each pixel

on the chosen line along the X-axis and the grey value for the pixel along the

Y-axis.

Distance

This command allows you to determine the distance of a straight line within
the digital image. | ' ' :

To measure the distance of a straight line:

e Select Distance from the Analyze menu.
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e The cursor will change to a pencil. Define a line by click-and-dragging the
mouse to the location desired for measurement.

e The Analysis Results window will appear, displaying the distance
between the two points in pixels. If a calibration procedure has been
performed the distance will be displayed in the correct units defined in
the calibration. '

s Click on the Analysis Results window close box to end the procedure.

Angle

This command allows you to determine the angle defined by three points
within the digital image.

To measure an angle:

o Select Angle from the Analyze menu.

o The cursor will change to a pencil. Define the angle by clicking the
mouse at the vertex of the angle, next define one side by dicking the

mouse and then define the other side.

e The Analysis Results window will appear, displaying the angle being
measured.

e Click on the Analysis Results window close box to end the procedure.
Area

This command allows you to determine the perimeter and area of a traced
closed figure.

Calibrate

This commands allows you to define an unit of measurement for all
dimensional analyses.

To define the name and size of a measurement unit
¢ Select Calibrate from the Analyze menu.

e The cursor will change to a pencil. Define a line by click-and-dragging
the mouse which represents an object or distance of known dimensions.

o The Calibrate Units dialog box 7l he displayed
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 Enter the desired uni'tsi of n}gasarqment (ie. m'illimeters, centimeters, etc.),
and the known dimensions of the calibration line in the desired units.

* Choose the OK bi_uttb‘n,' :bhlcl':_e yéi.l have confirmed the ir{put. All
dimensional analyses will be based on this calibration. To change the
calibration simple perform another calibration procedure.

The Options Menu

This group of menu items provides for setting user preference and default

display information.

Preferences

This command will allow you to select the small images to be displayed in the
Image Holder icon.

Palette

This command allows you to alter the palette (PAL) of the image being
displayed. Any type of linear or non-linear PAL can be applied to the image.
In addition, pseudo-color can be applied to any gray scale image. By selecting a
linear PAL the default image can be displayed. Selecting an inverse PAL
causes an inverse or negative image to be displayed. By experimenting with
the available palettes more detail may be visualized.

The Windows Menu

This group of menu items controls the display of certain components within
RADWORKS.

Tools

This command allows you to display or hide the Tools Palette. A check will
appear next to the selection. You can toggle between displaying or hiding the
palette.

Results

This command allows you to display or hide the Analysis Results window. A
check will appear next to the selection. You can toggle between displaying or
hiding the palette. '
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Clear
This command allows you to clear all windows that are displayed on the

screen. This command can also be used to abort or escape any procedure
within RADWORKS.

The Help Menu
About RADWORKS

This command allows you to display the About box. The About box displays
the copyright notice and the current version number of the program.

Help??

This command allows you to access the extensive on-line help program.
Refer to you Microsoft Windows Manual for instruction on using the Help

program.
RADWORKS Tools



